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Тема: Інструментальна платформа корпоративних додатків Java
Мета: Встановлення  та  налаштування  програмного  забезпечення  для
розробки компонент корпоративних інформаційних систем

До  складових  середовища  розробки  програмних  компонент  на
платформі Java EE відноситься наступне програмне забезпечення:

1.  Java  SE  Development  Kit  (JDK) –  базовий  набір  інструментів
платформи  Java  (Standard  Edition,  стандартної  редакції)  для  розробки  та
впровадження Java-додатків для десктопів та серверів [1]. Мінімальна версія,
яку  слід  використовувати,  є  8u181.  Файл дистрибутиву  має  префікс:
jdk-8u181 та відповідну до операційної системи подальше іменування.

2. Інтегроване середовище розробки додатків
Платформа  Eclipse.  Найпростіший  спосіб  встановити  або  оновити

середовище  розробки  Eclipse  це  використати  спеціальний  інструмент  —
Eclipse  Installer  [2].  Цей  інструмент  призначено  для  ефективного  вибору
версії та збірки Eclipse, що буде встановлюватись на компʼютер. На вказаній
у  посиланні  сторінці  можна  перейти  до  вибору  необхідного  пакету  та
встановити його самостійно без  допомоги Eclipse  Installer.  У вересні  2018
року  вийшли  нові  збірки  пакету  Eclipse  під  загальною  назвою
SimRel 2018-09.  Нова  збірка  Java  EE  включає  набір  інструментів  для
розробки JavaEE компонентів: EJB, JSP,  JPA, Mylyn, Servlets,  EGit тощо.  У
подальшому компонентний склад Eclipse можна змінити через Help->Install
New  Software...  Наявність  або  відсутність  компонент  можна  перевірити  і
через відповідні каталоги Eclipse - plugins и features.

3.  Сервер  додатків  WildFly   (www.wildfly.org).  Для  створення  та
виконання  додатків  Java  EE  необхідно  мати  сервер  додатків.  Одним  із
серверів  додатків,  що  повністю  підтримує  технології  Java  EE  є  WildFly.
Актуальною версією є 14.0.1. 

4. JBoss Tools 
(http://tools.jboss.org/downloads/jbosstools/index.html або для середовища
Eclipse https://marketplace.eclipse.org/content/jboss-tools
http://download.jboss.org/jbosstools/static/photon/stable/updates/core/
jbosstools-4.9.0.Final-updatesite-core.zip)
JBoss  Tools  є  набором  специфічних  плагинів  Eclipse  для  розробки,

тестування та розгортання додатків на базі серверів додатків JBoss AS або
WildFly. 



5. СУБД Derby (http://db.apache.org/derby/derby_downloads.html)
Apache  Derby  є  повнофункціональною  системою  управління

реляційними базами даних (СУРБД),  яка  базується  на  технологіях  Java  та
SQL. Її повністю написано та імплементовано на мові програмування Java.
Derby  надає  користувачам  заснований  на  стандартах  механізм  управління
базами даних, який може щільно вбудовуватись в будь-яке рішення на основі
Java, а також забезпечує цілісність даних і підтримку транзакцій.

Формат бази даних на диску, який використовує Derby, є портативним
та незалежним від платформи. Останнє полягає в тому, що бази даних Derby
можуть переміщатись з одного комп’ютера на інший без необхідності зміни
або модернізації даних. Додаток Derby може містити попередньо побудовану,
заповнену  базу  даних  і  ця  база  даних  буде  працювати  в  будь-якій
конфігурації Derby.

Останньою версією Apache Derby є 10.14.2.0.

ПРАКТИЧНА ЧАСТИНА

1. Встановіть JDK

2.  Для  інсталяції  Eclipse  розпакуйте  відповідний  файл  архіву  або
скористайтесь можливостями пакету eclipse-installer

3. Інсталяція та запуск WildFly
Останньою версією WildFly є 14.0.1 і його дистрибутив знаходиться у

файлі wildfly-14.0.1.Final.tar.gz. Після розпакування усі файли дистрибутиву
будуть  знаходитись  у  піддиректорії  wildfly-14.0.1.Final.  Для  нормальної
роботи   серверу  необхідно  встановити  значення  змінних  середовища
JBOSS_HOME  та WILDFLY_HOME  на  повний  шлях  до  піддиректорії
інсталяції.  Також  необхідно  додати  шлях  до піддиректорії  bin сервера  у
змінну середовища PATH. Це використовується для запуску серверу додатків
WildFly поза середовища розробки, наприклад, з командного рядка: 



<JBOSS_HOME>/bin/standalone.sh
Якщо сервер запустився коректно, то за допомогою Інтернет-браузеру

за адресою http://localhost:8080 буде показане вікно подібне до

Адміністрування  серверу  здійснюється  за  допомогою Administration
Console або за адресою http://localhost:9990. 

Для зупинки серверу з командного рядка слід використати команду: 

jboss-cli.sh  - - connect  - - command=: shutdown

Для перевірки правильності відпрацювання команди слід завантажити
(перезавантажити)  сторінку  http://localhost:8080 та переконатись, що сервер
зупинено.

Основним  засобом  перегляду  стану  сервера  додатків  і  результатів
виконання  тих,  чи  інших  операцій  слугує  перегляд  та  аналіз  лог-файлів
серверу додатків. Основний лог-файл серверу WildFly має назву server.log і
його розташовано у [JBOSS_HOME]/wildfly-14.0.1.Final/standalone/log 



4.  Підключення JBoss  Tools  до Eclipse  виконується  за  допомогою
відповідного  архіву  (наприклад,  jbosstools-4.9.0.Final-updatesite-core.zip),
який додається до системи без розпакування, наступним чином:

Help → Install New Software… → Add… → Archive… 
Також  JBoss Tools може бути встановлений через Eclipse Marketplace

5.  Тільки  після  інсталяції  JBoss  Tools  з’являється  можливість  для
підключення серверу додатків WildFly до IDE  Eclipse.  Для цього необхідно
вибрати File → New → Other.

1) У вікні, що з'явиться, обираємо Server → Server та натискаємо  Next.

2) Для  підключення серверу  WildFly  слід  обрати  відповідний тип  із
групи JBoss Community



3) Для вивчення та  дослідження технологій  Java  EE сервер додатків
WildFly буде використовуватись локально, тому слід залишити або
встановити  наступні  налаштування  при  його  підключенні  до  IDE
Eclipse

4) За допомогою кнопки Browse слід вказати домашній каталог сервера
WildFly. Інші налаштування можна залишити за замовчуванням, як
показано на наступному скриншоті:

Для  завершення  підключення  серверу  додатків  необхідно  натиснути
кнопку  Finish.  За  шляхом  Window  →  Show View  →  Servers  відкриється
вікно, що показує базові параметри стану серверу додатків, а також через яке
можна виконати його  налаштування,  переглядати  та  видаляти  встановлені
додатки. Також у цьому вікні можна запускати та зупиняти сервер.

5) Тепер слід перевірити здатність IDE Eclipse запускати та зупиняти
сервер  WildFly. Це можна зробити або за допомогою відповідних
засобів на панелі інструментів, або у вікні Server. При успішному



початку  запуску  Eclipse  автоматично  перемикнеться  на  вікно
Console,  в  якому  будуть  послідовно  виводитись  повідомлення
запуску  сервера.  Як  тільки  вивід  повідомлень  зупиниться,  можна
перевірити  працездатність  серверу  за  допомогою  браузеру  за
посиланням  http://localhost:8080, як це робилось раніше.

6) Зупинити сервер додатків WildFly можна за допомогою тих самих
засобів.

6. Інсталяція СУБД Apache Derby

Завантажте  ZIP  або  TAR  архів дистрибутиву  db-derby та розпакуйте
його. Інсталяція вміщує наступні директорії:

• demo — вміщує демонстраційні програми;
• bin —  вміщує  скрипт-файли для  виконання  утиліт  та  налаштування

середовища оточення;
• javadoc — вміщує  документацію  по api,  яку  було  згенеровано  із

коментарів файлів коду; 
• docs — вміщує документацію по Derby;
• lib — вміщує файли .jar серверу Derby;
• test — вміщує регресійний тест для серверу Derby.

Сервер  Derby має декілька способів запуску, які залежать від типу його
використання  та  впливають  на  загальні  налаштування.  У  випадку,  коли
необхідно запускати Derby із найменшою кількістю набору та встановлено
його  повний  бінарний  дистрибутив,  тоді  сервер  запускається  з
використанням  скриптів  для  командного  рядка.  Цей  метод  потребує
встановлення змінної  середовища оточення DERBY_HOME, включення до
значення змінної середовища оточення PATH розташування директорії  bin
встановленого дистрибутиву java, а також директорії DERBY_HOME\bin.

Якщо дистрибутив Derby не має директорії  bin або в ній не поновний
набір бінарних файлів, але є усі jar-файли дистрибутиву і на додаток не має
змоги  (або  навіть  бажання)  використовувати  скрипт-файли,  що
поставляються  із  Derby,  тоді  застосовується  метод  запуску  серверу  за
допомогою  файлу  derbyrun.jar.  Для  забезпечення  цього  методу
встановлюється  значення  змінної  середовища  оточення  DERBY_HOME  та
додається  до  змінної   PATH  місце  розташування  бінарних  файлів  java
(зазвичай це JAVA_HOME\bin). Файл derbyrun.jar не може бути переміщеним
із директорії його первинного розташування у дистрибутиві Derby. 

Ще  один  різновид  запуску  Derby  пов’язано  з  наступним:  відсутній
derbyrun.jar та відповідні скрипт-файли, або є необхідність у вивчені повного
синтаксису кожної  команди та деталізацій параметрів змінних середовища
оточення, або розробляються програмні додатки з використанням Derby. У
цьому випадку для запуску відповідних інструментів використовується або
повний синтаксис java,  або Derby використовується у java-програмах.  Для
забезпечення  цього  необхідно  встановити  відповідні  значення  для  змінної
середовища оточення DERBY_HOME, включити до значення змінної PATH



місце розташування файлів виконання java (наприклад, JAVA_HOME\bin), а
також  необхідно  знати  повну  назву  пакету  для  java-класу,  що  підтримує
роботу  серверу.  Змінна  середовища  оточення  CLASSPATH  повинна
включати необхідні JAR-файли. 

Одним із  найкращих варіантів є інсталяція Apache Derby до серверу
додатків  WildFly.  У  цьому  випадку  Apache  Derby  буде  запускатись
автоматично  із  сервером   WildFly.  Слід  зазначити,  що  необхідні  для
використання  БД  драйвери  Derby  JDBC  вміщуються  у  файлі  бібліотеки
derbyclient.jar. 

Для інсталяції Apache Derby в якості вбудованого серверу до WildFly
буде використовуватись jboss-cli.sh зі складу утиліт WildFly. Тому спочатку
запускається  сам  сервер  додатків  WildFly,  потім  — утиліта  jboss-cli.sh.  У
відповідь буде отримано командний рядок з префіксом [disconnected /]. Якщо
сервер додатків WildFly знаходиться у робочому стані,  то команда  connect
приєднає  до  нього  і  префікс  рядку  зміниться,  наприклад,  на  наступний
[standalone@localhost:9990] і тепер можна задавати команди.

Далі  інсталюємо  jar-файли  серверу Derby  як  модулі  до  WildFly  (у
прикладах,  що  наведено  нижче,  jar-файли  знаходяться  у  каталозі
/home/vgorbenko/db-derby-10.14.2.0-bin/lib) 

module add \
 --name=org.apache.derby \
 --resources=/home/vgorbenko/db-derby-10.14.2.0-bin/lib/derby.jar,/
home/vgorbenko/db-derby-10.14.2.0-bin/lib/derbynet.jar,/home/vgorbenko/
db-derby-10.14.2.0-bin/lib/derbytools.jar \
 --resource-delimiter=, \
 --dependencies=javax.api,javax.transaction.api

Наступним реєструємо драйвер JDBC під ім’ям "derby-embedded". Для
цього вводимо наступне:



/subsystem=datasources/jdbc-driver=derby-embedded:add(driver-name=derby-
embedded, \
 driver-module-name=org.apache.derby, \
 driver-class-name=org.apache.derby.jdbc.EmbeddedDriver, \
 driver-datasource-class-name=org.apache.derby.jdbc.EmbeddedDataSource, \
 driver-xa-datasource-class-name=org.apache.derby.jdbc.EmbeddedXADataSource)

У відповідь буде отримано: { "outcome" => "success" }
Тепер необхідно додати процедури запуску та зупинки Derby з ресурсу

github.com. Для цього необхідно вийти з командного рядку jboss-cli та ввести
наступні команди у командному рядку ОС:

git clone https://github.com/lbtc-xxx/derby-shutdown-service
cd derby-shutdown-service; mvn clean package
cp target/derby-shutdown-service.jar $WILDFLY_HOME/standalone/deployments

Тепер необхідно задати системні  властивості,  які  будуть  перемикати
Derby для прослуховування порту. Для цього знову слід запустити утиліту
jboss-cli.

/system-property=derby.drda.startNetworkServer:add(value=true)

Встановлюємо специфікації для цього порту Derby

/system-property=derby.drda.portNumber:add(value="1527")

Задаємо специфікацію розташування log файлу Derby

/system-property=derby.stream.error.file:add(value="${jboss.server.log.dir}/
derby.log")

Задаємо системне значення про існування derby.log

/system-property=derby.infolog.append:add(value="true")

Призначаємо DataSource 

Для звичайного DataSource (транзакції єдиної бази даних) слід ввести
наступне: 

data-source add \
 --name=DerbyEmbeddedDS \
 --driver-name=derby-embedded \
 --connection-url=jdbc:derby:${jboss.server.base.dir}/derbydata;create=t
rue \
 --jndi-name=java:jboss/jdbc/DerbyEmbeddedDS \
 --user-name=app \
 --password=app

Для XA DataSource (підтримують транзакції розподіленої бази даних)
вводимо: 

xa-data-source add \
 --name=DerbyEmbeddedXADS \
 --driver-name=derby-embedded \
 --jndi-name=java:jboss/jdbc/DerbyEmbeddedXADS \
 --user-name=app \



 --password=app \
 --same-rm-override=false \
 --xa-datasource-properties={ \
  "DatabaseName" => "${jboss.server.base.dir}/derbyxadata", \
  "CreateDatabase" => "create"}

У кінці слід зробити тест звʼязку

/subsystem=datasources/data-source=DerbyEmbeddedDS:test-connection-in-pool

Також  слід  переконатись,  що  скрипт  зупинки  серверу,  такий  як
/etc/init.d/wildfly не буде безконтрольно запускати прискорене завершення
роботи (наприклад, kill -9) , що може привести до псування даних у базі.

7.  Виконайте  усі  пункти  практичної  частини  лабораторної  роботи.
Підготуйте звіт, в який додайте скриншоти до усіх пунктів.

Список рекомендованої літератури

1.  Jakarta  EE  Specifications [Електронний  ресурс].  -  Режим  доступу:
https://jakarta.ee/specifications/
2.  Eclipse  Installer  [Електронний  ресурс].  -  Режим  доступу:
http://www.  eclipse  .  org  /  downloads  /  packages  /  installer  
3.  Java  EE  at  a  Glance  [Електронний  ресурс].  -  Режим  доступу:
http://www.oracle.com/technetwork/java/javaee/overview/index.html

http://www.eclipse.org/downloads/packages/installer
http://www.eclipse.org/downloads/packages/installer
http://www.eclipse.org/downloads/packages/installer
http://www.eclipse.org/downloads/packages/installer
http://www.eclipse.org/downloads/packages/installer
http://www.eclipse.org/downloads/packages/installer
http://www.eclipse.org/downloads/packages/installer
http://www.eclipse.org/downloads/packages/installer
http://www.eclipse.org/downloads/packages/installer
http://www.eclipse.org/downloads/packages/installer

	Лабораторна РОБОТА 1
	До складових середовища розробки програмних компонент на платформі Java EE відноситься наступне програмне забезпечення:

